Laboratorium tekstroniki

Cwiczenie 6: badanie wptywu ciata cztowieka na fale elektromagnetyczne

1. Wstep

Oddziatywania fal elektromagnetycznych na ciato cztowieka sg bardzo ztozone. W zakresie
matych czestotliwosci powodujg one tzw. efekt nietermiczny manifestujacy sie objawami
psychosomatycznymi, ktére sg trudne do badania i mierzenia, a ponadto wystepuja przy duzych
natezeniach pol.

W zakresie wielkich czestotliwosci (czestotliwosci mierzone w GHz) obserwowany jest tzw. efekt
termiczny oddziatywania fali na ciato cztowieka polegajgcy na zwiekszaniu temperatury w wyniku
pochtaniania energii fali. Ten efekt jest mierzalny i mozliwy do symulacji komputerowej.

Tkanki ciata zawierajag wode, biatka, ttuszcze, cukry, mineraty itd. W uproszczeniu tkanki
oddziatujg z falami radiowymi tak jak woda z dodatkiem cukru i soli. Woda wstawiona do
kuchenki mikrofalowej ogrzewa sie dzieki energii fali elektromagnetycznej (2,4 GHz), analogicznie
ciato cztowieka ttumi (przejmuje energie) fale elektromagnetyczne. llo$¢ energii pochtonietej
przez ciato na jednostke masy okresla parametr SAR — (ang. Specific Absorption Rate) ttumaczony
jako przyrost energii absorbowanej, ktérego jednostkg jest W/kg. W przypadku ekspozycji na
fale, ktora powoduje w catym organizmie SAR=4 W/kg, przyrost temperatury wewnetrznej jest
mniejszy od 1 °C co uznaje sie za granice efektu termicznego. Dla pracownikéw poddanych
oddziatywaniu fali elektromagnetycznych dopuszczalny poziom SAR usredniony w catym ciele
wynosi 0.4 W/kg, dla populacji generalnej SAR=0.08 W/kg. Parametr SAR mozna obliczy¢ z

ponizszej zaleznosci: .
SAR =~ | E|
Yo,

gdzie:

e [E-natezenie pola elektrycznego
e o-— przewodnosc elektryczna [S/m]
e p -gesto$é materiatu [kg/m’]

W przypadku projektowania systemdéw radiowych przeznaczonych do pracy w poblizu ciata
cztowieka nalezy przeanalizowa¢ problem odwrotny: w jaki sposéb ciato wptywa na rozchodzenie
sie fali elektromagnetycznej. Trzeba zaprojektowaé specjalne anteny, ktére mogg pracowac przy
ciele oraz nalezy obliczy¢ ile energii zostanie wyttumione przez ciato, a ile dotrze do odbiornika.

Badanie oddziatywania ciata na fale mozna przeprowadzi¢ za pomocg symulacji komputerowych
wykorzystujgcych metode rdznic skonczonych w dziedzinie czasu (FDTD). W tej metodzie
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komputer rozwigzuje rdznicowe rownania Maxwella przyblizone do réwnan réznicowych, a kazdy
obiekt badany podzielony jest na komdrki elementarne. Ta metoda zalecana jest do obliczania
oddziatywania fal na ciato cztowieka.

W ramach ¢wiczenia przeprowadzone zostang symulacje oddziatywania fali na ciato za pomocg
programu XFdtd firmy Remcom. Zbadane zostang rozktady pdl elektromagnetycznych w poblizu

ciata poddanego ekspozycji falg ptaska oraz wptyw ciata na charakterystyke promieniowania
anteny.

2. Badanie rozktaddéw pdl elektromagnetycznych w poblizu ciata poddanego ekspozycji falg
ptaska

Symulacje przeprowadzone zostang przy zatozeniu, ze fala elektromagnetyczna bedzie falg
ptaska, o czestotliwosci 2,45 GHz. Wykorzystany zostanie heterogeniczny model ciata cztowieka
NMR — Hershey, o wielko$ci woksela 5mm.

ZADANIE 1:

Zbadac rozktad pola elektromagnetycznego w poblizu oraz wewnatrz ciata poddanego ekspozycji
na energie fali ptaskiej. Obliczy¢ parametr SAR

Kolejne etapy realizacji zadania:

polecenie widok ekranu

1 Uruchamiamy program XFdtd Fhp

< g Name: [Unsaved Praject

Project Path: <Unsaved Project>
Frequency Range of Interest | Notes | Display Uniks | Advanced

This setting controls the frequency range of interest for this project. This frequency range allows XFdtd to
automatically provide some simulation parameters and output Formatting.

Minimum: | 2 GHz Maximum: | 3 GHz

W oknie ,,Project properties”
2 ustawiamy czestotliwosci na zakres
od 2 GHz do 3 GHz

Revert Cancel

Unsaved Project - XFdtd 7.5.1.3 {64-hit)

Edit View Macros Help

B New Project
[ New Project from Ternplate..
| Open Exsting Project..
. . . = New Window 3
Importujemy model ciata cztowieka e swerae
. . 3 Save Project &5
3 Menu File -> Import —> Voxel object [0 Swue Project oy .

f ¥ Close Project
e Export Parts
[4]] Manage Project Templates..
< Create Project Archive.., 2
(D) Recent Projects »

@ Quit
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+ ¥Fdtd - Import VariPose Voxel Data ==

Input filets)

Data File: fmcomfvariPose 1.3/data/af_man_Smm.mmf| | Eromse...

Daka Specification

du: S om
» dy: [Smm
Importujemy model .

4 af_man_5mm.mmf naciskajac R
P rZYCi S k OK Create dfault materil definitions For tissuss For which EM parameters

cannot be determined.

yisualization Options

Decimation Factors (1 |5 ————————

Yiew Bounding Box Only

Cancel

XFdtd - Vireel Import Materials =

o The voxel data defined in the file =
C:/Progean Files (x36)/Remcon/Veribose 1.3/data/af_man_San.mnf
s LupOKTEd SuccessTuLlY.

The tizsues for the imported wowel dats sre listed below. Haterial definiticms
Eor each tissue wsre sither reused LT they alisady sxisted in the project (based
©n mexe) or added to the project. The list below suamarizes the action taken

The naterials assigned to eoch tissus type can be edited afeer iapore
ing on the iwported wedsl, selecting "Naterial” and then

1 hasignasnta”.

s (1.e. Ruown tissue Types).
cgpea.

The vorel meTadava conrained 39 TiEsue
The voxel data references 39 unique ©
© known tizsue types were not used

© Enown CiSsus types were not sssigned s vaterlal definivion.
© tissue ids were unknown.

© materisl definitions were reused snd 38 were added ta the project.

The parasecer 'materialfrequency’ was adied to the project with
= value of | GH2. This parameter controls st what frequency the

5 Zatwierdzié |iste materiai’éw (OK-) The BENLY GZeATAd t1850 PATAMECECS VLLL be EvAluACed For Sisalation.

ID Tizsus Name Seatus
2 bile Added (from 'Bile')

3 body £luid Added (frem 'Blood')

4 eys cornss Added (from 'Eye (Cornes)')

s Added (from 'Fat!

e Added (frex 'Lysphnode ')

7 Added (frow 'Mucous Newbrans')

8 Added (fxom 'Bone')

1 Added (frem 'Spinal Cord!)

17 Added (from 9

23 Added (from

30 Added (frem !

48 Added (fxom *

49 Added (from

65 blacd vessel Added (frem 'Blood Vessel Uall')

68 liver Added (from 'Liver' B
B8 gall bladder Added (from 'Gallbladder’) =

o
R

Unsaed Project® - ¥Fdtd 7.5.13 (64-bie)

Fle Edt View Macros Help
FTrELIC
eBsslcia =R
Project: Unsaved Project

obracamy model o 180 stopni wokot I

e
s 5 Viaveguide Tntifm View Parts List
O S I X . # External Excital Select Parent(s)

6 @ Static Voltage |
& semeens D SutVisble

Parts, prawy klawisz, Modify -> = o st

Near Field § 5 Valume Visuslization Options

specify Orientation B st

& Matmrin .

@ AR Averag]
§ Thermatsef b Edit

|/ Definitions | Rensme...

W Delete ool

View Nates

"R
EECCR
P Unnsved rnct
© e

Obrot deklarujemy wokét lokalnego
uktadu wspétrzednych — os$ U.
(przycisk przy literze U, rotate

around U’ = 180)

Unsaved Project* - ¥Fdtd 7.5.13 (64-bit)
File Edit View Macros Help

L

Definiujemy zasilanie modelu falg o ke o
=] Parts

8 ptaska: External excitation -> New et
Plane Wave

45 Waveguide Interfaces

* FarZone Sensors
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Uriaved Poecr 04 T3 13 NER
. [r———.

Definiujemy parametry fali: katy
9 padania: Theta=90, Phi=90,
polaryzacja=Theta

+ ¥faveguide Interfaces
El- % External Excitations
= 4 Plane Wave
e Automatic
@ Static Voltage Points
£l (5 Sensors

Definiujemy parametry opisujace * Ports
. .. = Mear Field S
fale w dziedzinie czasu: o MeAr el sensan
10 . Far Zone Sensors
Definitions-> Waveforms -> (S SAR Sensor
Automatic ) sAR Aueraging hensar

§ Thermal Sensor

= | | Definitions
_I Materials
7 Circuit Component Definitions

- \Waveforms

] & mame: | autometic Type: |Sinuscid -
Frequency: [zesa |

Time Domain

g 1 —
11 Ustawiamy czestotliwos¢ fali: E = =
. . 0 0.0001 0.0002 0.0003 0.0004 0.0005 0.0006 0.0007 0.0008
Type=Sinusoid, Frequency=2.45 GHz Time (us)
g 0 Frequency Domain
%—20
T -40
= .60
5-80
2’“ 0 0.5 1 1.5 2 2.5 3 3.5 4 4.5

Frequency (GHz)

=] 'E‘:' Sensors
" Ports

¥ Mew Paint Sensar

* FarZone Sensors
@ SAR Sensor w4 Mew Sensor on Model Surface

Definiujemy sensor pola bliskiego: = _
. &) 5AR Averzging Sensor B Mew Rectangular Sensar
12 | Sensors->Near Field Sensors ->New 8 Thenmat Sensor

= ||| Definitions

Planar Sensor X oo
7 Circuit Camponent Definitiq ™
™ Whavefarms (&) MNew HAC Sensor

B Autornatic % Edit

“ Sensor Data Definitions

ity Mew Planar Sensor

¥ Mew Solid Part Sensor

# Mew Solid Box Sensar
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Wieuw
Specify Orientation Properties
Point: Fixed Position Mormal: Fixed Direction
X: | 300 rorn X1
¥: 172.5 mm ¥ o Fick Simple Plane
& -947.5 mm &0
Definiujemy orientacje ptaszczyzny
(Planar Sensor) na ktdrej
przedstawione zostang wyniki
symulacji tak aby przechodzita przez
13 srodek ciata i byta réwnolegta do
jego osi. Wektor normalne;j
ptaszczyzny jest réwnolegty do osi x,
a wspotrzedne punktu srodkowego
jak na obrazku
= | || Definitions
P H- | Materials
Okreslamy parametry sensora: = .
e . . 0 Circuit Component Definitions
Definitions -> Sensor Data Definition
14 L = | Waeeforms
-> Surface Sensor Definition A Autormatic
== Sensor Data Definitions
»_‘1; A Name: | surface Sensor Definition
Fields To Save
XE H B il
Field ¥s Time
Scattered E Scattered H Scattered B
Steady E Steady H Steady B Steady J
. . Fields vs Frequency - i
Definiujemy parametry sensora tak Dispated Pawer Dersty
. . . + Scattered fields are clollected Dnhf ?EetnhuEsingdaﬂ Ext_?_mal Excita”tio?. g
15 | aby rejestrowat zmiany w czasie pola e e
elektrycznego S o R T e A R
Sampling Time Range
Start Time: |0 * timestep | start of Simulation
End Time: |1000* timestep | End of Simulation
Samping Interval: |10 * timestep R/ Use Project Yalue
Revert Cancel Apply.
= 3 Sensors
" Ports
=+ =% Mear Field Sensars
= #4 Planar Sensor
il Surface Sensor Definition
]
Wtgczamy sensor parametru SAR: Far Zone Sensors
16 & =
SAR Sensor -> Enable > . @ SetVisible
& SAR Avsraging Sensar
§, Thermal Sensor @ Setlnvisible
= | || Definitions %/ Enable
- [ Materials % Edit v
7 Circuit Component Definitions i
=™ Wiaveforms '
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Wiew
SAR. Sensor
KonflgurUJemy parametry §ensora ® Enable Collection of Raw SAR Data
17 | SAR: SAR Sensor->properties->full Mote: If SAR Averaging
id Collection Region will be used, SAR
gri sensor does not need
® Full Grid Box ko be modified,
I |
Uruchamiamy sensor SAR
usredniajgcy obliczenia w 1g lub 10g | ser Averagng | Tissue Materials
tkanki M Enable SAR Averaging
Sensors->SAR Averaging sensor X/ Compute L-gram Avd. SAR Data
18 _>Enab|e ¥ Compuke 10-gram Avg, SAR Data
Averaging Region
W oknie properties dek]arujemy ® Full Grid Box Auto Subregion
usrednianie w masie 1g i 10g, dla
catego modelu (Full Grid)
45 Wavequidif® Wiew Parts List
. E- % E | E:
Dla modelu cztowieka ustalamy B § Py o ectParentty
. . . . . <@ SetVisible
rozmiar oczka siatki dyskretyzujgce;j &l A )
1 @ Static volt @ Set Invisible
19 przestrzen na Smm: 2- (2 Sensors t Wolume Visualization Options
Prawym klawiszem na modelu Ll Giiciing / Mehin ' raperties
. . B Near F Material r ‘ Meshing Properties
cztowieka otwieramy okno: B b Pl
d . "‘ﬂ "p Edit * | Enable PrOGrid Grid Regions
Grl Ing propertles » FarZonll Rename... W Disable PrOGrid Grid Regions
'/:ﬁ SAR Se| I Delete Del | Meshing Order 4
Ij STRA ~ Wiew Motes ‘ Mesh Type 4
b 7 ' % Include In Mesh
= [ ]! Definitions I
&
GridV off
® Use Prodrid Grid Regions
Target Cell Size: 0.796209 mm
Minimum Cell Size: 0.393104 mm
Custom Min Cells Per Wavelength 15
20 Wytaczamy algorytm ProGrid Clstom i Feature Size
Custom Min Cells Across Feature ]
Custom Number Of Padding Cells 3
Custom Boundary Refinement Ratio 3
Custom Boundary Refinement Number Of Cells 3
Add Grid Regions Even when Part is Unmeshed
Rewert Cancel Apply
&
Grid Regions
Use ProGrid Grid Regions
% Enable Grid Regions = advanced
Basic Specification
21 Definiujemy parametry siatki
. . . . Target: Smm
dyskretyzujacej dla obiektu Cell sizes
Minimum: 0.5 X Ratio
Boundary Extensions: 0 mm
Revert Cancel Apply
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Zapisujemy projekt w pliku o .
22 pisujemy p .J . P File->Save As....
wybranej nazwie
-
O @&
S -_S\mulatmns
Create simulation: | £3 ForD || Queue: . Selected simulation: | 4+ || & @® Pararoters
Id Name Date Created Status 2
Uruchamiamy symulacje:
23 Prawy panel programu ->
Simulations -> Create simulations
XFotd - Create FDTD Simulation =
i vome: | ]
.~ Choose Source - {External Excitation: Plane Wave )
Discrete Sources | Waveguide Sources.
Wykonujemy symulacje:
24 . .
Create &Queue Simulation
@ setup Parameter Sweep - (OFF)
@) Setup 5-Parameters - (OFF)
£ Frequencies of Interest - (Use Waveform Frequency)
/' Specify Field Formulation - (Tokal/Scattered)
@ 5pecify Termination Criteria - (Detect Convergence: -40 d6)
& niotes
P e
(0]
S [ Simulations
9 List Project [¥] Unlist Project - || € Refresh Search: * ® Perareers
A . Project Name Sensor Domain Result Type B g
Po zakonczeniu symulacji Fa— o y e Ehoa
. . . , Plane Wave Libraries
przechodzimy do analizy wynikow: 8 varaing sevor (.
SAR Averaging Sensor (1g
55 Prawy panel ->Results R sensor{ o)
Wybieramy w kolumnie sensor ->
Planar sensor, wybieramy result type
-> E —> Filed
Simulation D Result Type Sensor Sensor Type:
000001 E-Field (E) Planar Sensar z Surface Sensar
'
W oknie prezentujgcym wyniki ‘
wybieramy zaktadke ,sequence” i 4
26 wybieramy za pomoca suwaka I‘l'
chwile czasowq dla ktorej W
. . Il |
przedstawiony zostanie rozktad pola i
elektrycznego
e e .
Nalezy zebra¢ wyniki ilustrujgce
27 zjawisko wnikania fali w gtab ciata
oraz ttumienie fali spowodowane
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obecnoscig ciata

W oknie ,results” wybieramy wyniki
zwigzane z parametrem SAR,
SAR Sensor (Raw)

W oknie prezentujgcym wyniki
zmieniamy Sequence Axis na X, oraz
ustalamy maksymalny zakres Y range

Setup Sequence

Sequence Axis: ¥

28

SAR, man-test : 000001 : Run0001

| Hide Others Unload

Statistics

~ | Frequency: 2.45 GHz

R/ Show Scaled Yalues

Display Mode: | Flat -
Decimation: | Finest -
Size Factor: | 1,00 z

Show Bounding Box

Decimation ustalamy na finest

W zaktadce sequence przeglagdamy

29 o .
wyniki symulacji

‘iject Narme

‘ |Sensor ‘ ‘Domain

‘ ‘ResultType

Poréwnujemy wyniki symulacji Sar
Sensor (Raw) z wartosciami
usrednionymi dla 1g i 10g
(okno Results)

All

s man-test

30

All
Time

Plane Wave

Raw Steady-State Far Zone...
SAR Averaging Sensor (10..
SAR Averaging Sensar (1g ..
SAR Sensor { Raw)

All
E-Field (E)

Nalezy poréwnac wyniki obliczen dla
SAR usrednionego w masie i
nieusrednionego, a nastepnie
okresli¢ warto$ci maksymalne

31

Powtarzamy symulacje zmieniajgc

amplitude faliz 1 V/m na 100 V/m

External Excitations -> Plane Wave
-> Properties

» Project: man-test

£ [ Parts

AF 'man' Mesh- Smm
3 2 = Circuit Components
43 Wavequide Interfaces

E)- % External Excitations

B Autoratic

Location | Properties

EEE ]
Name:  Flane ave

Waveform: | Automatic

Amplitude: (100 vim

Nalezy poréwnac wyniki obliczen
SAR uzyskane dla fali o amplitudzie 1
i 100 V/m

33

| Incident Amplitudes: £x: 0000000 ¥/m
Ey: 0,000000 ¥/m
E2: -1,000000 ¥/m

3.

ZADANIE2:

Badanie wptywu ciata na charakterystyke promieniowania anteny.

Zbadac charakterystyke promieniowania dipola poétfalowego pracujgcego w pasmie 2,45 GHz w

wolnej przestrzeni oraz w poblizu ciata cztowieka.

Kolejne etapy realizacji zadania:

polecenie

widok ekranu

Uruchamiamy program
XFdtd

T
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o) M Mame: [Unsaved Praject
Project Path: <Unsaved Project>

Frequency Range of Inkerest | Notes | Display Units | Advanced

This setting contrals the frequency range of interest for this project. This frequency range allows XFdkd to
H H tomaticalk ich lati t d autput format
W fo) kn ie, P rOJ ect automatically provide some simulation parameters and output formatting
- . Minimum: |  GHz Maximum: | 3 GHz
properties™ ustawiamy

2 | czestotliwosci na zakres od
2 GHz do
3 GHz

Unsaved Project - XFdtd 7.5.1.3 (64-bit)
File Edit View Macros Help
TERE
ST oce
EREPPEFEEE

Project: Unsaved Project

p— ci.+ Create Newr P BE Assembly
£ B View Parts List (811 Parts) | 8] Extrude
% Ex @ Exportto CAD File.. @ Revolve
B Stes suppans » (9 Sheet Body

SetVisible Sheet Bady from Faces

SetInvisible €&, Wire Body

W panelu Parts wybieramy e =

Create New Cylinder R

Thennal Sensor
i 4 Cone
£ [ ]! Definitions
A Materials Q Torus
= Circuit Component Definitions | <4 Pyramid
¥ Waveforms & Prism
Sensor Data Definitions A Frustum
=- £ FOTD -
& Outer Boundary ) M
[ ornid 4’ Birdcage
o Mesh
% Scripts
= Graphs
& Groups
Tnswed Project Eaed 15,13 (06

e Edit Wew Macoi Help

+ =B

P ame: | Gt

Definiujemy parametry
cylindra stanowigcego
4 jedno ramie anteny:
Height: 26mm
Radius: 1mm

Trivved Fraper - XFad 1511 G000

# Extermal Exe
B Statc Voltage Peints

Analogicznie definiujemy 2
ramie anteny jako cylinder
o identycznych wymiarach.
5 W zaktadce Specify
Orientation zmieniamy
wspotrzedng Z nowego
cylindra na 27mm
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Definiujemy nowy materiat:

idealny przewodnik
elektryczny PEC:
Definitions -> Materials ->
New Materials

W oknie definicji materiatu
wybieramy wiasciwosci:
Electric -> Perfect
Conductor

Name: PEC

Uncaved Projece - XFah 13,03 (G4

ik e View Mics Hilp

*ECRLPOC

PRSI
Project: Unsaved Praject
wr.

iRe
i

Przypisujemy materiat do
obiektow:
Prawym klawiszem na
obiekcie (cylindrze)
wybieramy opcje Material,
a nastepnie materiat (PEC)

" Unsaved Praject” - XFeltd 7.5.1.3 (64-bit)

File Edit View Macros  Help

YTEAESDC

i g Create New
it 0 Modify
45 wavequit}, Ecit Feature
% External|@ poolean

Y smi(\rnh Fa—-w—r
- & Sensors e rark

0 ports | Select Parent(s)
) Mear | @ Exportto CAD File

? FarZe
Q@ sar
@ sar

§ Ther
B[] Definitiof [§ Material »
£ [ Mate b Edit 5
o
| Cireu,

7 jgyel ll Delete Del

= Sensq & Order y

2 LD = free N
& OuterBoundary

@ SetVisible
@ Setlnisible

(& Gridding / Meshing >

[ Rename

Analogicznie jak w
poprzednim zadaniu
wykonujemy etapy 19 — 21
ustalajac parametry siatki
dyskretyzujacej dla
cylindréw,
rozmiar oczka 0.5mm

 Unsaved Project* - XFdtd 7.5.1.3 (64-bit)
Fle Edit View Macros Help

*ErBE&OC

“ Project: Unsaved Project

<= Circuit Components
%5 Waveguide Interfaces
# External Excitations
@ Static Voltage Points
(9 Sensors
* Ports
(% Near Field Sensors
* Far Zone Sensors
() SAR Sensor
(S 5AR Averaging Sensor
B Themmol Sensor
&[]/ Definitions
£ [ Materials
B e
[ Circuit Component Definitions
4 Waveforms.
"= Sensor Data Definitions
= {3 FTID
W/ Outer Boundary
BH orid
@ Mesh
% Scipts
= Graphs
I Groups

Grid Regions
Use PrOGrid Grid Regions
X Enable Grid Regions

Basic Specfication

 Advanced

Target: [0.5 mm

Cell Sizes
Minimum; 0.5

Boundary Extensions: 0 mm

Fixed Points
Use Automatic Fixed Poirks
Automatic Discovery Options
(3€] wire Endpoits
3] Edaz Comers
[3] Endpoaints of Axis-aligned Edges
[ pen Elipse Center Points
[ Closed Ellipse Center Points
[ Edae Loops Bounding Box

Minimum size: [0 mm

% Ratio

Boundaries
383

Lower: [ 1
Bz

BEx
Upper: B0
Bz

el G

Definiujemy zrédto
zasilajgce antene:
Circuit komponent -> New
Circuit Component ->
New Feed Definition

“ Unsaved Project” - XFdtd 7.5.1.3 (64-bith

File Edit View Macros Help

*FRE&OC

" Project: Unsaved Project
Bl Parts

¥ Cylinder
¥ Cylinder

@ Static Yoltage Points
B & Sensors
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Wskazujemy punkty
podtaczenia zasilania za
10 pomocg strzatek.

Wybieramy zblizone do
siebie podstawy cylindréw

Endpoint 2

N & Mame: | automatic Type: | Sinusoid -
.. Frequency: [2.a56H] |
Definiujemy parametry

Time Domain

. .. g 1 —
sygnatu analogicznie jak w : B ==
etapie 11 poprzedniego E == ——
11 . 0 0.0001 0.0002 0.0003 0.0004 0.0005 0.0006 0.0007 0.0008
zadania, Time (us)

0 Frequency Domain

Czestotliwos¢ 2,45 GHz

Magnitude (dBa)
b b R
o

0.5 1 1.5 2 25 3 ik a 4.5
Frequency (GHz)

Definiujemy Sensor pola
dalekiego.
Sensors -> Far Zone Sensors
12 | Ustalamy zakres katéw na

view

Goonetry | rapanns &
Counlinate System Types Tets, i

s "

Start A 01 LioSre Tetahe | Stot Amghes 0 Uom S i ke

stop Angfes (320 merement; 5+ step Angles 360 merement; <+

360 stopni w kazdej
ptaszczyznie
Y List Project E]l €% Unlist Project HQREFresh ] Search: * ®
Project Name | | sensor | |pomain || [Resutt Type |
Il Al All All

e dipal Component Discrete Frequencies Ayial Ratio
Component 1 Directivity
Far Zone Sensar E-Field (£}
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